
Frontline Technical Support: Frontline_TechSupport@Teledyne.com

TM Quick Start
Guide

Computer System Requirements
Supported Systems

l Operating System: Windows 10 and 11
l USB:USB 2.0 and later

Minimum Requirements
l Processor: Core i5 at 2.7 GHz
l RAM: 4 GB
l Free Hard Disk Space on C: drive: 20 GB

Install Software

l From Download: Download the latest Frontline
installer from FTE.
https://fte.com/products/default.aspx. Once
downloaded, double-click the installer and follow
the directions.

When the installation is complete pin the Wireless
Protocol Suite icon to your taskbar.

1. Front Panel Controls

The Teledyne LeCroy Sodera™ front panel is shown below. The panel provides controls to power up and shut down the Frontline
Sodera hardware, and it provides indicators to show the power, battery, and capture status.

https://fte.com/products/default.aspx
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Sodera Front Panel Controls and Indicators

Power On/Off Button: Press and hold the button for at least 1/2 second, and then release the button to power on or power off the
system.

Pressing and holding the button for at least five seconds will initiate an emergency shut down sequence.

Status Indicators: Colored LEDs show the status of power and capture.

Indicator Color State Status Indicated

Power None Off Unit is powered off

Green Constant Unit is switched on

Red Blinking Unit is approaching its maximum thermal load and should be shut
down.

Constant Unit has been automatically disabled due to thermal overload.

Amber Constant Unit is powering down.

Battery State None Off No battery present

Green Constant Battery present and is at normal operating voltage

Slow Flash Battery charging

Amber Fast Flash Battery fault

Host Interface None Off No host interface is connected.

Green Constant Host interface is connected.

Amber Constant Internal error

Capture None Off Unit is not actively capturing data

Green Constant Unit is capturing data

Red Constant Unit has engaged RF overload protection; the RF signal is too
strong.

Table 1 - Sodera Front Panel Status Indicators

Antenna SMA Connector: Antenna attaching point.

Battery Charge : The following table shows the charge state of the installed battery. When the battery is not installed, all LEDs are off
except when the unit is in the process of powering up. In that case they repeatedly light up in sequence.

Indicator LEDs Charge Status
Greater than 80%

Between 60 and 80%

Between 40 and 60%

Table 2 - Sodera Battery Charge State
LED Indicators
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Indicator LEDs Charge Status
Between 20 and 40%

Less than 20%

Not Active

Table 2 - Sodera Battery Charge State LED Indic-
ators(Continued)

Excursion Mode: When configured for Excursion mode, pressing this button will begin data capture—the same as the
Record/Recording button on the Sodera Window DatasourceToolbar. The Excursion Mode button is inactive when Sodera is
connected to a computer. To operate in the Excursion mode, the Sodera hardware must have been previously configured from the
Wireless Protocol Suite prior to disconnecting from the computer. Refer to the Wireless Protocol Suite Hardware and Software User
Manual for Excursion mode operating details.

2. Rear Panel Connectors

The rear panel is shown below. The panel provides connectors for external power, ProbeSync™, HCI, and for connection to the
computer hosting theWireless Protocol Suite.

Sodera Rear Panel Connectors

+12 VDC: Connection to the Teledyne LeCroy supplied AC-to-DC power adapter, or a 12 VDC auxiliary vehicle outlet system can be
used.

ProbeSync™ IN/OUT: Used for synchronizing multiple capture devices. Sodera can act as a clock source (central) device providing the
clock to synchronize timestamping with connected target (peripheral) devices. When operating as a central device the OUT RJ-45
connector provides the synchronizing clock. The synchronizing clock can be attached to a peripheral Sodera or a Frontline 802.11, for
example. When operating as a peripheral device, the IN RJ-45 connector receives the synchronizing clock from the central Sodera unit.

HCI USB 1/HCI USB 2:USB Type B and a USB Type A connectors allow capture of HCI USB data. HCI USB 1 and HCI USB 2 are
independent groupings of the Type A and Type B connectors. The HCI USB 1 connectors use the same Sodera unit internal interface as
the Sodera HCI POD1 UART pins. Likewise the HCI USB 2 connectors use the same internal interface as the Sodera HCI POD2 UART pins.
Therefore you cannot simultaneously capture USB and UART on the "1" interface or on the "2" interface. Refer to Connecting for USB
Capture and Connecting for HCI/WCI-2 & Logic Capture in the Wireless Protocol Suite Hardware and Software User Manual.

PC HOST : USB 2.0 port for connecting Sodera to the host computer where the Wireless Protocol Suite resides. This connector provides
host computer command, control, and data transfer.

Note: At this time all other rear panel connectors are inactive.
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3. Attach Antenna

Antenna Attachment Point

Remove the Frontline Sodera™ hardware from the box and attach the antenna to the SMA connector on the front panel. The base of
the antenna can be carefully rotated by 90 degrees, so that the antenna points upward.

4. Connecting for ProbeSync™

ProbeSync allows a Frontline Sodera unit and a 802.11 hardware to be connected together to run off of a common clock, ensuring
precise timestamp synchronization while capturing Bluetooth and WiFi technologies. One device will act as the central device by
providing the clock to the peripheral device receiving the clock. The devices are connected in a daisy-chain configuration. The Sodera
unit must be the central device. Refer to the following tables, to Rear Panel Connectors on page 3, and to the 802.11 back panel shown
in the image below.

Sodera 802.11 Sodera 802.11
PROBESYNC OUT PROBESYNC IN OUT IN

Central Peripheral X X

Sodera Synced to 802.11

Using a CAT 5 Ethernet cable, less than 1.5 meters (4.9 feet), insert one end into the central device connector. Insert the other end into
the peripheral device connector.

Each central/peripheral device will have a separate datasource window open. The Bluetooth and WiFi packets can be viewed in the
Coexistence View for either datasource.
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ComProbe 802.11 Back Panel

5. Applying Power

The Sodera hardware is powered by three methods: the Teledyne LeCroy supplied AC-to-DC adapter, an external DC power source that
can include power from an automobile auxiliary power source and an optional internal battery.

To apply power to Sodera use one of the three methods:

1. Connect the provided AC-to-DC power adapter to the +12VDC connector on the rear panel and then connect the adapter into
an AC source.

2. Connect a DC power source supplying +12 VDC directly to the +12VDC connector on the rear panel.
3. Install the battery.

To start the Sodera Analyzer, depress the Power button on the front panel for at least 1/2 second and then release . This action will
provide a clean start for Sodera hardware. The battery charge state indicator LEDs will repeatedly flash in sequence while the unit
powers up.

The front panel Power indicator LED will be green.

Should the front panel Power indicator begin blinking red, the Sodera hardware is approaching thermal overload temperature
between 50 °C and 60 °C (122 °F and 140 °F) and should be shut down. When the hardware reaches thermal overload it will
automatically shut down and the Power indicator will be a constant red.
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6. Sodera Data Capture Method

When the Sodera Analyzer is connected to the Host PC running theWireless Protocol Suite the Start Page window will display the
Sodera option.

Wireless Protocol Suite: Start Page

Select Sodera to bring up theWireless Protocol Suite window. TheWireless Protocol Suite Application icon will be placed in your taskbar at the bottom of your
screen.

Wireless Protocol Suite Application Icon
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7. Wireless Protocol Suite

Wireless Protocol Suite

8. User Configuration Overview

The Frontline product Sodera is capable of simultaneously capturing and demodulating RF channels and packet types defined in
Bluetooth Specifications up to and including 5.1. The user is not required to specify the addresses of the devices to be captured or their
roles (central or peripheral) during the connection lifetime. Prior to capturing data the user does not need to enter any information
(PIN, OOB, long term key, link key) used to encrypt or decrypt data. Sodera provides live simultaneous capture of all 79 Classic
Bluetooth channels and 40 Bluetooth low energy channels storing data for both live and post capture analysis.

Sodera uses a two-stage capture-analysis process. First, Record will activate the Sodera to begin capturing data from all Bluetooth
devices in range. In the Analyze stage, the user selects one or more wireless or wired devices for analysis and Sodera will begin sending
captured data that is to/from those devices to the Wireless Protocol Suite software. The data appears in various views:
Summary Pane, Message Sequence Chart, Coexistence View, Bluetooth Timeline, Low Energy Bluetooth Timeline, PER Stats, etc.

If any keys needed for decryption are known from past captures those keys are automatically applied to the devices under test. Prior
to protocol analysis the user can enter any unknown keys. Sodera will identify the specific key necessary for data decryption, for
example Link Key, Passkey, PIN, Temporary Key. Decryption keys are entered into the Security pane. The Security pane is available
from the View menu.
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Security Pane

The user can configure the record options from the Analyzer Toolbar. The default settings are sufficient for capturing most Bluetooth
connections. Details of the configuration settings are in the Wireless Protocol Suite Hardware and Software User Manual available to
download from FTE.com or in Frontline Sodera on-line help.

http://fte.com/
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9. Record: Begin Capture

When starting a capture session all of these actions occur:

l The active status of all devices is cleared in the Device Database pane and theWired Devices pane.
l The Security pane is emptied.
l The Event Log pane retains all prior logged events.

On theWireless Protocol Suite Toolbar, click on the Start Record button or select Start Record from the Capture
menu option. The Start Record button is also available in theWireless Protocol Suitemain window. In the Main
window you can also select Start Recording from the Capturemenu option. When the Start Record button

changes to Stop Record, the Sodera hardware is capturing data from all active Bluetooth devices within range and is recording data on
the PC.

On theWireless Protocol Suite Toolbar, clicking on the Stop Record button, or selecting Stop Recording from the
Capturemenu options will halt live capture. From the Main window you can click the Stop Record button or
select Stop Recording from the Capture menu list to stop recording as well.

The Device Database View populates with any newly discovered devices. Selecting devices for analysis can be done while recording.

The Security View will show all encrypted Bluetooth links.

The Event Log View will begin to populate with information, warnings, and error messages.

The Status Bar will show a running total of captured packets.

Note: Starting a new capture session will clear all unsaved data from both the Sodera hardware and the
Wireless Protocol Suite. If it has not been saved, then a pop-up warning message will appear.

10. Selecting Devices for Analysis

Once a capture session starts by clicking on Start Record on the Main Window Toolbar, data from all active devices within range or
data from wireless or wired connections is being captured. To analyze the data using theWireless Protocol Suite, select specific
devices of interest to include in the analysis.

In the Device Database view, place a check in the row of each active device to be analyzed. Active devices can also be selected

while the recording is in process.

Note: Data filtered by the device selection is an “OR” function, not an “AND” function. When selecting device1,
device2, device3,... the recorded data filtered into the analyzer is data involving device1 OR device2 OR device3
OR .... However, if in the Options menu, analysis of LE Empty packets is selected, an AND function is included.
For example: (device2 AND LE Empty packets) OR (device3 AND LE Empty packets).

The following table lists some common data capture and device selection scenarios.

Scenario Wireless/Wired Devices View Selection
Analyzing traffic between a Peripheral Device Under Test (DUT) and
its Central.

Select only the Peripheral DUT for analysis

Table 3 - Common Data Capture and Device Selection Scenarios
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Scenario Wireless/Wired Devices View Selection
Analyzing all traffic involved in Inquiries In the Options menu select Analyze Inquiry Process

Packets

Table 3 - Common Data Capture and Device Selection Scenarios (continued)

Once Devices are selected, analysis of the capture can begin.

11. Starting Analysis

The analysis begins by clicking on the Start Analyze button or Selecting Start Analyze from the Capturemenu.
Alternatively, click on the Start Analyze button in theWireless Protocol SuiteMain window. In the Main window
you can also select Start Analyzing from the Capturemenu. The Sodera analyzer will begin sending captured

packets involving the selected device(s) to the Wireless Protocol Suite software.

Once analysis has begun, you cannot change the device selection. All device rows in the Device Database View are
grayed-out. To stop the analysis, click on the Stop Analyze button. You can then change your device selection and
restart analysis by clicking on the Start Analyze button.

To stop the analysis, click on the button in the Sodera datasource or click the button on

theWireless Protocol SuiteMain window You can also select the Stop Analyze option in the Capturemenu in the Sodera datasource
or Stop Analyzing option in the Capturemenu in the Main window as well.

Conducting analysis from a capture file is identical to the live capture method.

Wireless Protocol Suite: Main Window

:

The Application Window icon will be shown in your task bar, see below:
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Wireless Protocol Suite Application Icon

12. Saving Analyzed Data to Disk

Note: Start Record is not available when viewing a previously recorded Capture file. Start Analyze/Stop Analyze
is available inWireless Protocol Suite application window, allowing different analyses to be performed on
previously recorded and saved captures.

Note: Choose File Location from the File menu to change the default file location.

1. Click on either

l the Start Record button on the datasource toolbar.,
l or the Start Record under Capture in the datasource,,
l or the Start Recording under the Capture option in the Main window.

The Sodera analyzer will begin capturing data from all wireless devices within range and from all connected wired devices.

2. In the Device Database andWired Devices View select the active devices for analysis.

3. : Click on either

l the Start Analyze button Start Analyze under the Capture menu in the Sodera datasource window,
l or c kick on Start Analyze button in theWireless Protocol Suite Main window,
l or Start Analyzing under Capture menu

to begin capturing data traffic.

4. Files are placed inMy Capture Files folder by default and have a .cfa extension.
5. Watch the Status Bar on the Wireless Protocol Suite Main window to monitor how full the file is.

6. Click on Stop Record button to stop recording.

7. Click the Stop Analyze button to stop analyzing. 



Frontline Technical Support: Frontline_TechSupport@Teledyne.com

8. To clear captured data, click the Clear icon .
l If you select Clear after stopping analysis, a dialog appears asking whether you want to save the data.

o You can click Save File and enter a file name when prompted .
o If you choose Do Not Save, all data will be cleared.
o If you choose Cancel, the dialog closes with no changes.

l If you select the Clear icon while a capture is occurring:
o The capture stops.
o A dialog appears asking if you want to save the capture.
o You can select Yes and save the capture or select No and close the dialog. In either case, the existing capture

file is cleared and a new capture file is started.
o If you choose Cancel, the dialog closes with no changes.

13. Sodera Technical Specifications/Service Information

l Dimensions: 159 mm wide X 57 mm tall” X 165 mm deep” (6.3” X 2.3 " 6.5" X mm)
l Weight: 1.0 kg (2.2 lb)
l Humidity: Operating: 0% - 90% (0 °C – 35 °C)
l Temperature: -10 °C to +40 °C (14 °F to +104 °F)
l Power Input: 12 VDC (tip positive)
l Max Power: 25 W

l Battery: NB2037FQ31

Caution: There is a risk of explosion if the battery is replaced by an incorrect type. Dispose of old
batteries according to your local regulations.

Service Notes

The Sodera hardware does not contain any user serviceable items. Any repairs and maintenance must be performed by a service
technician that has been trained and approved by Teledyne LeCroy.

Before any service is performed on Sodera, all power sources must be removed. This includes removing the battery and disconnecting
any power sources from the 12 VDC input power connector on Sodera. Typical power sources include external AC/DC power supplies
or auxiliary power sources from a vehicle.

Internal Fuse Information
l Manufacturer: Littlefuse
l Type: OmniBlok
l Current rating: 5A
l Speed rating: Very Fast Acting
l Voltage rating: 125V ac/dc

This quick start guide provides sufficient information to begin the data capture. Detailed hardware and software information is
contained in the Frontline Sodera User Manual. The manual is available on FTE.com.

© 2017 Teledyne LeCroy, Inc.

The Bluetooth SIG owns the Bluetooth word mark and logos, and use of such marks is under license.
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